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Introduction
Employees can use Microsoft Dynamics® GP Personal Data Keeper to enter and 
submit Project Accounting timesheets and expense reports whether or not they’re 
connected with the corporate network. After returning to the office, they can 
synchronize data with the PDK database.

Employees can view the status of timesheets and expense reports, view historical 
data, and print reports. Manager approval of timesheets and expense reports can be 
implemented.

The administrator can choose the companies and projects that will be available in 
offline mode and the employees who can approve specific timesheets and expense 
reports. 

For more information about integrating U.S. Payroll and Canadian Payroll with 
Personal Data Keeper, refer to the documentation for these modules.

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an understanding of how to use the features of 
Personal Data Keeper, and how it integrates with Project Accounting and the rest of 
the Microsoft Dynamics GP system.

To make best use of Personal Data Keeper, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Personal Data Keeper that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Personal Data Keeper.

The manual is divided into the following parts:

• Part 1, Installation and setup, contains information on how to install Personal 
Data Keeper and how to create users, user classes, security settings, SQL 
options and the system password.

• Part 2, Procedures, contains information on how to enter transactions, viewing 
inquiries, and printing reports.
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Personal Data Keeper Help menu gives you access to user assistance resources 
on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and suggestions.

The warning symbol indicates situations you should be especially aware 
of when completing tasks.

The multicurrency symbol points out features or procedures that apply if 
you’re using Multicurrency Management.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print The (>>) symbol indicates a sequence of actions, such as selecting items 
from a menu or toolbar, or pressing buttons in a window. This example 
directs you to go to the File menu and choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. To change the 
way required fields are highlighted, choose Setup >> Preferences >> Display, and 
specify a different color and type style.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft®, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Part 1: Installation and setup
You can customize Personal Data Keeper to meet your requirements by using the 
Setup options. It offers a wide range of flexibility, from defining accounting tasks to 
specifying the employee records that will be displayed on the screen or in print.

The following topics are discussed:

• Chapter 1, “Installation,” describes how to install Personal Data Keeper.

• Chapter 2, “System setup,” provides procedures for setting up Personal Data 
Keeper.

• Chapter 3, “Offline use setup,” provides procedures for setting up your 
company to accept employee timesheet and expense reports in either offline or 
online mode using a remote connection via the Internet.

• Chapter 4, “User preferences,” provides procedures for customizing Personal 
Data Keeper, including defining settings for viewing required fields and setting 
up user passwords.
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Chapter 1: Installation
This part of the documentation describes how to install Personal Data Keeper.

The following topics are discussed:

• Before you begin
• Completing a new installation
• Upgrading from Release 8.0 or 9.0

Before you begin

You must install Microsoft Dynamics GP with Project Accounting before you install 
Personal Data Keeper.

If you are using Microsoft Dynamics GP with Service Pack 5 or later, the Microsoft 
Visual C++ 2005 Redistributable Components are required. To install this 
component, see the Frequently Asked Questions Regarding the New Service Pack, 
Hotfix, Compliance Update Process for Microsoft Dynamics GP 10.0 (https://
mbs.microsoft.com/customersource/downloads/servicepacks/
MDGP10_FAQNewPatchProcess). 

Before upgrading Personal Data Keeper you must:

• Verify all transaction dates to be sure they are within the fiscal period set in 
Microsoft Dynamics GP.

• Offline users must synchronize their data with the server before you install 
Personal Data Keeper.

See Upgrading from Release 8.0 or 9.0 on page 8 for more information.

Completing a new installation

Use the installation wizard to complete a new Personal Data Keeper installation.

To complete a new installation:
1. On the server computer, install or upgrade Microsoft Dynamics GP and Project 

Accounting to Release 10.0.

2. Insert the Microsoft Dynamics GP 10.0 CD labeled CD2 in the CD-ROM drive.

The Microsoft Dynamics GP installation window opens. If the window does not 
open, browse the CD and double-click the Setup.exe file.

3. Under Additional Products choose Personal Data Keeper, and then choose 
Install.

4. In the welcome window, choose Next.

5. Read the software license agreement. Select to accept the terms and choose 
Next.

6. If you are installing on a computer that will be used by an administrator, select 
the Admin Setup Options checkbox.

https://mbs.microsoft.com/customersource/downloads/servicepacks/MDGP10_FAQNewPatchProcess
https://mbs.microsoft.com/customersource/downloads/servicepacks/MDGP10_FAQNewPatchProcess
https://mbs.microsoft.com/customersource/downloads/servicepacks/MDGP10_FAQNewPatchProcess
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You must install the Administrator component of Personal Data Keeper on at least one 
workstation to set up users, user classes, system registration, and security options. 

7. Select the destination folder in which to install Personal Data Keeper. Choose 
Next.

8. Enter the name of the SQL server containing your Microsoft Dynamics GP data 
or select Do not create a data source. Choose Next.

9. Choose Install.

10. When the Installation Complete window opens, choose Exit.

Upgrading from Release 8.0 or 9.0

You can upgrade to Release 10.0 from Release 8.0 or 9.0. Use the installation wizard 
to upgrade a Personal Data Keeper installation.

To upgrade from Release 8.0 or 9.0:
1. Verify all transaction dates in Personal Data Keeper to be sure that they are 

within the fiscal years that have been set up in Microsoft Dynamics GP.

2. Synchronize all offline Personal Data Keeper data with the server computer.

3. On the server computer, we recommend that you back up the DYNAMICS and 
company databases in SQL Server.

4. On the server computer, upgrade Microsoft Dynamics GP and Project 
Accounting to Release 10.0.

5. Insert the Microsoft Dynamics GP 10.0 CD labeled CD2 in the CD-ROM drive.

The Microsoft Dynamics GP installation window opens. If the window does not 
open, browse the CD and double-click the Setup.exe file.

6. Under Additional Products choose Personal Data Keeper, and then choose 
Install.

7. In the welcome window, choose Next.

8. Read the software license agreement. Select to accept the terms and choose 
Next.

9. If you are installing on a computer that will be used by an administrator, select 
the Admin Setup Options checkbox.

You must install the Administrator component of Personal Data Keeper on at least one 
workstation to set up users, user classes, system registration, and security options. 

10. Select the destination folder in which to install Personal Data Keeper. Choose 
Next.

11. Enter the name of the SQL server containing your Microsoft Dynamics GP data 
or select Do not create a data source. Choose Next.
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12. Choose Install.

13. When the Installation Complete window opens, choose Exit.

14. You must synchronize modified forms and reports. See Microsoft Dynamics GP 
Technical support for more information.
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Chapter 2: System setup
This part of the documentation provides you with information about how to set up 
Personal Data Keeper.

The following topics are discussed:

• Logging in to Personal Data Keeper
• Selecting a company
• Setting up a user ID
• Setting up timesheet options for a user
• Setting up expense report options for a user
• Setting up a user class
• Setting up user class options
• Setting up user class timesheet options
• Setting up user class expense report options
• Setting up security options
• Setting up the system password
• Entering registration keys

Logging in to Personal Data Keeper

Use the Welcome to Personal Data Keeper window to select a user and a company 
to log in with. You can change the current user or company without closing the 
program.

To log in to Personal Data Keeper:
1. Start Personal Data Keeper.

(Start >> Programs >> Microsoft Business Solutions >> Personal Data Keeper)

2. Select a server.

3. Enter the user ID you’re logging in with.

You must log in as the system administrator to create new users. See Setting up a user 
ID on page 12 for more information.

4. Enter the password for the user ID you’re logging in with.

5. Choose OK to log in.
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Selecting a company

Use the Login window to select a company. You may be set up to use more than one 
company; if so, you can switch companies using the Login window.

To select a company:
1. Open the Login window.

(File >> User and Company)

2. Select a company from the list.

You can change the current user using the Change User button if other users have been 
created.

3. Choose OK to log in.

Setting up a user ID

Use the User Setup window to create user IDs. You must be logged in as the system 
administrator to create user IDs.

To set up a user ID:
1. Open the User Setup window.

(Setup >> System >> User)

To open the User Setup window, you must enter the system password. See 
Setting up the system password on page 20 for more information.

2. Enter a user ID. If you have previously created a user ID, you can choose the 
user ID in the lookup list, otherwise, you will need to create a new user ID.

The Licenses Remaining field displays the remaining number of users who can 
use Personal Data Keeper. See Entering registration keys on page 20 for more 
information.

You can’t change the user ID after the record has been saved. If you want to change a 
user ID, delete the user record and reenter the user record with another ID.

3. Enter or select a company.
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4. Select an employee ID. The employee name and class ID will be displayed.

5. Select the manager and supervisor for the employee. Your entries will be 
compared with the user type assigned to the user. 

6. Choose the user type.

If you want employees to approve their own timesheets, you can set them up to 
be their own manager or supervisor. 

7. Enter prefixes for timesheet batch and expense report batch.

8. Enter and confirm a password for the user ID. See Setting up your user passwords 
on page 28 for more information about how users can change their passwords. 

If you are using Microsoft SQL Server™ 2005 or later on Windows Server® 2003 
or later, advanced password options are available.

Enforce Password Policy Mark this option to force users to adhere to the 
same password policies that have been established on the Windows Server 
domain.

Enforce Password Expiration Mark this option to force users to change 
their passwords after the number of days that is defined by the Windows Server 
domain password policies. This option is available only if you have marked the 
Enforce Password Policy option.

Change Password Next Login Mark this option to force users to change 
their passwords the next time they log in to Personal Data Keeper. This option is 
available only if you have marked the Enforce Password Policy option.

9. Enter the number of months of Multicurrency Management information to use.

10. Choose whether the user can approve timesheets or employee expenses at the 
supervisor, manager, or administrator level. 

11. Choose whether the user can use the Report Writer, Import Utility, or Modifier 
programs that were installed with Personal Data Keeper.

12. Choose Timesheets to set up timesheet options for this user. For more 
information, see Setting up timesheet options for a user on page 13.

13. Choose Expenses to set up expense report options for this user. For more 
information, see Setting up expense report options for a user on page 15.

14. Print a report to verify the settings.

15. Save the user record.

Setting up timesheet options for a user

Use the Timesheet Settings window to specify timesheet options and delegates for a 
user. Delegates are users who are authorized to enter timesheets on behalf of the 
employee selected in the User Setup window. This functionality is only available for 
individual users.
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To set up timesheet options for a user:
1. Open the Timesheet Settings window

(Setup >> System >> User >> Select a user >> Timesheets button)

2. Choose timesheet options.

The following table lists the various options and their descriptions:

3. Select default timesheet type if the system is set up to use weekly reporting 
periods.

4. Select one or more delegates by choosing the corresponding user names from 
the Employees column. Choose Add to assign the selected user as a delegate.

If this option is marked The user can:

Default to assigned projects in 
lookup

View projects that are only assigned to them in the 
Projects window.

Use timesheet template Use timesheet templates for new timesheet entries.

Allow Billing Notes Entry Enter billing notes during timesheet entry. You can 
use billing notes to include additional details about a 
timesheet entry.

Allow Change in Billing Type Change the billing type during timesheet entry.

Allow Change of Job Position Change the job position during timesheet entry.

Allow change of Pay Code Change the pay code during timesheet entry.

Allow Change of Department Change the department during timesheet entry. This 
option is useful when creating timesheets for 
employees working outside their departments. 

Allow Entry of None Project Enter NONE project numbers for timesheet 
transactions.

Approval Adds Allowed Add new entries in the review and approval windows.

Approval Edits Allowed Modify submitted transactions in the review and 
approval window.

Remember last project number Copy the last project number entered for the previous 
line to the new line.
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To unassign a delegate, select the user from the Delegates column and choose Remove. 
To delete all delegates, choose Remove All. You can’t delete the current user from the 
Delegates list.

5. Choose OK to return to the previous window.

Setting up expense report options for a user

Use the Expense Settings window to specify expense report options and delegates. 
Delegates are users who are authorized to enter expense reports on behalf of the 
employee selected in the User Setup window.

To set up expense report options for a user:
1. Open the Expense Settings window

(Setup >> System >> User >> Select a user >> Expenses button)

2. Choose expense report options.

The following table lists the various setup options and their descriptions:

3. Select the default payment method. Options include Cash, Company Credit 
Card and Personal Credit Card.

4. Select one or more delegates by choosing the corresponding user names from 
the Employees column. Choose Add to assign the selected user as a delegate.

To unassign a delegate, select the user from the Delegates column and choose Remove. 
To delete all delegates, choose Remove All. You can’t delete the current user from the 
Delegates list.

5. Choose OK to return to the previous window.

If this option is marked Then the user can:

Default to assigned projects in 
lookup

View projects that are only assigned to them in the 
Projects window.

Allow Billing Notes Entry Enter billing notes during expense report entry. You 
can use billing notes to include additional details 
about an expense report entry.

Allow Change in Billing Type Change the billing type default during expense report 
entry.

Allow Entry of None Project Enter NONE project numbers for expense report 
transactions.

Approval Adds Allowed Add new entries in the review and approval windows.

Approval Edits Allowed Modify submitted transactions in the review and 
approval window.

Remember last project number Copy the last project number entered for the previous 
expense report.
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Setting up a user class

Use the User Class Setup window to restrict a group of users to the windows, 
reports and information that are needed to perform specific tasks. For example, you 
can use user classes to control who can submit timesheets or approve expense 
reports. User classes can minimize the amount of effort required to set up users.

To set up a user class:
1. Open the User Class Setup window.

(Setup >> System >> User Classes)

2. Enter a class ID, then enter a description to identify the class further. To select 
an existing user class, choose the Class ID lookup button to display the lookup 
list.

Mark Default to specify whether the class ID will be used as the default class. 
By marking this option, all subsequent users that belong to the class will have 
similar timesheets and expense report options.

3. Choose Personal Data Keeper from the Product list. The Type list displays the 
items that the class can use in Personal Data Keeper. Choose Project from the 
Series list.

4. Select an item in the Access list to grant access to individual items. After an item 
is selected, an asterisk (*) will be displayed next to the item. To select all 
displayed items, choose Mark All. To clear all selections, choose Unmark All.

5. Choose Options to set up additional options for this user class. For more 
information, see Setting up user class options on page 17.

6. Choose Save.
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Setting up user class options

Use the User Class Options window to select options to be used for the user class 
selected in the User Class Setup window. Options include expense report approval 
and timesheet approval settings.

To set up user class options:
1. Open the User Class Options window.

(Setup >> System >> User Classes >> Select a user class >> Options)

2. Enter the user ID for the manager.

3. Enter the user ID for the supervisor.

4. Enter the timesheet batch prefix and expense report batch prefix for the user 
class.

5. Enter the number of months of Multicurrency Management information to use.

6. Specify timesheet and expense report approval options.

7. Specify administrator privileges to grant authority to a user class to approve an 
active document without having manager or supervisor approving privileges.

8. Specify tools that the current user can use.

System tools such as Report Writer, Import and Modifier are available only to those user 
classes that have the appropriate license.

9. Print a report to verify the settings.

10. Choose Timesheets to set up timesheet options for this user class. For more 
information, see Setting up user class timesheet options on page 17.

11. Choose Expenses to set up expense report options for this user class. For more 
information, see Setting up user class expense report options on page 18.

12. Choose OK to save the settings.

Setting up user class timesheet options

Use the Timesheets window to specify timesheet options for the user class.
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To set up user class timesheet options:
1. Open the Timesheets window.

(Setup >> System >> User Classes >> Select a user class >> Options button >> 
Timesheets button)

2. Specify the timesheet options for the user class. 

The following is a list of setup options and their descriptions:

3. Choose OK.

Setting up user class expense report options

Use the Expenses window to specify expense report options for the user class 
selected in the User Class Setup window.

To set up user class expense report options:
1. Open the Expenses window.

Setup >> System >> User Classes >> Select a user class >> Options button >> 
Expenses button

If this option is marked The user can:

Default to assigned projects in 
lookup

View projects that are only assigned to them in the 
Projects window.

Use Timesheet Templates Use timesheet templates when entering new 
timesheets.

Allow Change in Billing Type Change the billing type default during timesheet 
entry.

Allow Billing Notes Entry Enter billing notes during timesheet entry. You can 
use billing notes to include additional details about a 
timesheet entry.

Allow Change of Job Position Change the position during timesheet entry.

Allow Change of Paycode Change the paycode during timesheet entry.

Allow Change of Department Change the department during timesheet entry. This 
option is useful when creating timesheets for 
employees working outside their departments.

Remember last project number Copy the last project number entered for the previous 
timesheet.
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2. Specify the expense report options for a user class.

The following is a list of options and their descriptions:

3. Choose OK.

Setting up security options

Use the Security Setup window to specify who will be using Personal Data Keeper 
and to grant or limit the access of individual users to certain features, such as access 
to windows, files and reports.

To set up security options:
1. Open the Security Setup window.

(Setup >> System >> Security)

2. Enter or select a user ID and company name.

3. Select Personal Data Keeper from the Product list.

4. Select a type from the list. The items, reports, files and windows in the Type list 
grant access to reports, files and windows respectively.

5. Select Project from the Series list.

6. Select items in the access list. After an item is selected, an asterisk (*) will be 
displayed next to the item. To select all displayed items, choose Mark All. To 
clear all selections, choose Unmark All.

If this option is marked The user can:

Default to assigned projects in 
lookup

View projects that are only assigned to them in the 
Projects window.

Allow Change in Billing Type Change the billing type default during expense report 
entry.

Allow Billing Notes Entry Enter billing notes during expense report entry. You 
can use billing notes to include additional details 
about an expense report entry.

Remember last project number Copy the last project number entered from the 
previous line.
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7. Print a report to verify the settings.

8. Choose OK to save the settings.

Setting up the system password

Use the System Password Setup window to assign a password to restrict user access 
to system setup windows for the company you’re using. A system password must 
be assigned for each company.

To set up the system password:
1. Open the System Password Setup window.

(Setup >> System >> System Password)

2. Enter the current password in the Old Password field. Enter a new password. 
Confirm the new password by reentering it.

3. Choose OK to save the system password.

Entering registration keys

Use the Registration window to enter the registration keys. User registration is 
based on the number of users you are licensed for. For example, if you purchased 
the system with a license for 99 users, you will not be able to enter more than 99 
users. It is important that you enter the registration keys before you start creating 
transactions.

You can use Personal Data Keeper even if no registration keys have been entered. However, 
you will be limited to one user and 25 transactions. If you entered the maximum number of 
transactions before you have entered the registration keys, you won’t be able to save entries.

To enter registration keys:
1. Open the Registration window.

(Setup >> System >> Registration)

2. In the Site Name field, enter the name of the company you specified when you 
acquired your registration.
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3. Enter the registration keys. The keys are for Personal Data Keeper, Report 
Writer, Import Manager and Modifier. Registration keys can vary in length for 
each field. The number of remaining users available is displayed in the Licenses 
Remaining field in the User Setup window.

4. Choose OK to save the record.
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Chapter 3: Offline use setup
You can use Personal Data Keeper even if you are not connected to the office 
network and perform transactions such as timesheet and expense report entry by 
maintaining a set of offline tables that synchronize with their equivalents on the 
office network.

The following topics are discussed:

• About offline use
• Setting up for offline use

About offline use

There are two modes: Connected and Offline. You are in Connected mode when 
your computer is connected to the office network. You are in Offline mode when 
you are using the offline tables stored in your Personal Data Keeper folder. All 
offline tables are maintained in the Personal Data Keeper folder. The files must not 
be moved. You can work in Offline mode even if you are connected to the office 
network.

After Personal Data Keeper has been set up for Offline mode, you can choose to 
start in either Connected or Work Offline mode. Otherwise, the system starts up in 
Connected mode.

When you quit Personal Data Keeper, you will be asked if you want to synchronize 
your data and change the status of active documents to Remote.

The Remote status informs users with approval authority that you have started the 
document but have disconnected from the network and taken the document with 
you.

While offline, you can continue to modify the documents you were working on in 
the office or enter new documents. You can use document number formats to create 
documents that won’t interfere with documents created by other users.

Setting up for offline use

Use the Offline Setup window to select companies and transfer documents that you 
want to synchronize before disconnecting from the office network.

You must have read and write permissions and remote access to your office network to use 
the remote capabilities.



P A R T  1 I N S T A L L A T I O N  A N D  S E T U P

24 P E R S O N A L D A T A K E E P E R

To set up for offline use:
1. Log in using one of the created user IDs.

2. Open the Offline Setup window.
(Setup >> Offline)

3. Choose the companies you want to access offline and choose Insert. You can 
select multiple companies.

4. Choose the Offline Company lookup button to select a specific offline company 
and display the projects under that company. Then, select or enter the projects 
in the company that can be used offline. 

To delete a displayed project, select the project in the scrolling window and 
choose Delete Row from the Edit menu.

5. Choose projects for offline access.

Only projects from the selected companies in the Offline Support column and projects 
can be used in Offline mode.

6. Save the settings.

Your offline data has been synchronized for the user you last saved the settings for. You 
must not switch among users if you are using offline mode from one machine. If you do 
log on in connected mode using another user ID other than the offline user, you must be 
careful not to synchronize the current data if you want to preserve the offline users data. 
Offline data is regenerated each time it synchronizes with the system.

7. Restart Personal Data Keeper and choose to Work Offline if you want to work in 
offline mode. When you log in, the system displays the Offline mode on the 
toolbar.
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Chapter 4: User preferences
User preference settings include defining settings for viewing required fields, 
timesheet and expense reports, and user passwords.

The following topics are discussed:

• Setting up user preferences
• Setting up user display preferences
• Setting up timesheet preferences
• Setting up expense report preferences
• Setting up your user passwords

Setting up user preferences

Use the User Preferences window to make changes to certain options that each user 
can customize. Options include choosing the key to move from one data entry field 
to another, selecting the default report destination and changing the user password.

To set up user preferences:
1. Open the User Preferences window.

(Setup >> Preferences)

2. Mark the Horizontal Scroll Arrows option if you want to use horizontal 
scrolling fields. Horizontal scrolling fields will display account numbers that 
are too long to view in text fields. If you use horizontal scroll fields, you can set 
up scrolling buttons to view and then modify the numbers.

3. Choose the default entry key. You choices are TAB and RETURN.

Return If you choose RETURN as the entry key, you can press the ENTER key 
after you make an entry to move to the next field in the window. If you choose 
RETURN and you press SHIFT+ENTER to accept an entry, the default button (such 
as OK or Save) in the window control area will be selected.

Tab If you choose TAB as the entry key, you can press the TAB key to move 
from field to field in windows. If you choose TAB and you press ENTER to accept 
an entry, the default button (such as OK or Save) in the window control area 
will be selected.

4. Choose either Printer or Screen as the default report destination. When you 
choose to print a report and the Report Destination window opens, your choice 
will be marked as the default.

5. Save the settings.
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Setting up user display preferences

Use the User Display Preferences window to customize display preferences. You 
can customize how windows will be displayed. You might want to choose a color or 
font style that will draw your eye to the fields that are required entries before you 
can save transactions or other records.

To set up user display preferences:
1. Open the User Display Preferences window.

(Setup >> Preferences >> Display button)

2. Specify how fields with link capability will be displayed. If you use the link 
capability to view more detailed information frequently, you might want to 
choose a color or font style that will easily catch your attention.

Specify the font color of labels for fields with link capability. If you specify 
another color for required fields and link is also required, the label will be 
displayed according to the specifications for required fields.

3. Select the font style of labels for fields with link capability.

4. Specify how required fields will be displayed. Choose the font color of field 
labels that you are required to make an entry for. Choose the font style of labels 
for required fields.

5. Specify how contents of the fields will be displayed in windows. 

6. Specify how alternating lines in scrolling windows will be displayed.

7. View your changes in the Preview window.

8. Click OK to save the settings.

Setting up timesheet preferences

Use the User Preferences – Timesheets window to choose the default timesheet 
entry type and assign delegates to enter your timesheets.
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To set up timesheet preferences:
1. Open the User Preference – Timesheets window.

(Setup >> Preferences >> Timesheets button)

2. Mark the Default to assigned projects in lookup option if you want the project 
lookup to display only the projects that are assigned to you.

3. Mark the Use timesheet templates option to use timesheet templates when 
entering a timesheet.

4. Mark the Remember last project number option if you want to copy the last 
project number entered for the previous line to the new line.

5. Select the default timesheet type.

The weekly based timesheet option is only available if your system is set up to use 
weekly reporting periods.

6. Assign delegates to enter timesheets on your behalf. Use the Employee List to 
select employees and add them to the Delegates list.

7. Choose OK to save the settings.
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Setting up expense report preferences

Use the User Preferences – Expenses window to select your expense report 
preferences and assign delegates to enter your expense reports.

To set up expense report preferences:
1. Open the User Preferences – Expenses window.

(Setup >> Preferences >> Expenses button)

2. Mark the Default to assigned projects in lookup option if you want the project 
lookup to display only the projects assigned to you.

3. Choose the Remember last project number if you want the last project you 
selected to be displayed on the next line

4. Assign delegates to enter expense reports on your behalf. Use the Employee 
List to select employees and add them to the Delegates list

5. Choose OK to save the settings.

Setting up your user passwords

Use the User Password Setup window to enter or modify your password .

To set up your user passwords:
1. Open the User Password Setup window.

(Setup >> Preferences >> Password button)

2. Enter current password, then enter a new password. Confirm the new 
password by reentering it.

3. Choose OK to save your settings.
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Part 2: Procedures
This part of the documentation contains information about creating, correcting and 
viewing a transaction. You can enter a timesheet or an expense report, save it or 
submit it and then view the details after they have been submitted.

You can use inquiries to review transaction details of the timesheets and expenses 
you have entered. Instead of going through each record or waiting for reports to be 
printed, you can perform inquiries quickly by selecting only those records you want 
to view on the screen.

The following topics are discussed:

• Chapter 5, “Transactions,” provides procedures about entering weekly, 
standard, or offline timesheets and expense reports. Timesheet and expense 
report approvals also are discussed.

• Chapter 6, “Inquiries,” provides procedures about viewing employee, 
timesheets and expense report information.

• Chapter 7, “Reports,” provides procedure about printing history reports.
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Chapter 5: Transactions
You can enter timesheet and expense report transactions in both connected and 
offline modes. Transactions also include approving timesheet and expense reports 
for managers and supervisors who have administrator privileges.

To be able to post timesheets to U.S. or Canadian Payroll, you must specify the 
following settings:

• Mark Use Pay Codes for Unit Cost in the Project Setup window.

• Mark Post to Payroll in the Timesheet Setup window.

• Select Employed by Company in the PA Employee Options window.

The following topics are discussed:

• Default pay codes
• Entering weekly timesheets
• Modifying unposted weekly timesheets
• Entering standard timesheets
• Modifying unposted standard timesheets
• Approving timesheets
• Entering expense reports
• Entering detailed information for expense reports
• Entering additional information for expense reports
• Entering payments for employee expenses
• Modifying an unposted employee expense transaction
• Approving employee expense transactions
• Entering transactions offline

Default pay codes

You can use the Timesheet Setup window in Project Accounting to set up default 
pay codes based on the employee, budget, or cost category. When you select to use a 
rate table with a project, the pay codes used for timesheet entries for a project will 
depend on the corresponding employee-pay code combination in the rate table. The 
unit cost for the pay code will be used in the timesheet transaction.

Employee Use the default pay code entered in the PA Employee Options window 
in Project Accounting. If no pay code has been selected in that window, the default 
pay code entered in the Budget Detail Entry window in Project Accounting will be 
used. If no pay code has been selected in that window, the default pay code entered 
in the Cost Category Maintenance window in Project Accounting will be used.

Budget Use the default pay code entered in the Budget Detail Entry window in 
Project Accounting. If no pay code has been selected in that window, the default pay 
code entered in the PA Employee Options window in Project Accounting will be 
used. If no pay code has been selected in that window, the default pay code entered 
in the Cost Category Maintenance window in Project Accounting will be used.
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Cost Category Use the default pay code entered in the Cost Category 
Maintenance window in Project Accounting. If no pay code has been selected in that 
window, the default pay code entered in the PA Employee Options window in 
Project Accounting will be used. If no pay code has been selected in that window, 
the default pay code entered in the Budget Detail Entry window in Project 
Accounting will be used.

A message will be displayed during timesheet transaction entry telling you that the 
employee-pay code combination doesn’t exist in the rate table if default pay codes 
are blank in the PA Employee Options window, the Budget Detail Entry window, 
and the Cost Category window in Project Accounting. 

Entering weekly timesheets

Use the Timesheet Entry window to create individual employee timesheets. You can 
use weekly timesheets to enter timesheet information in a day-to-day basis.

Weekly timesheets are used only if your system is set up to use weekly reporting periods.

Timesheets are used to track the number of hours spent by an employee on a 
project. You can enter non-project related information as well.

To enter weekly timesheets:
1. Open the Timesheet Entry window.

(Transactions >> Timesheet >> Weekly layout)

2. Enter the document date.

3. Enter the number for reporting periods to be included in the timesheet. 
Reporting periods are useful in tracking the number of hours expended on a 
project within a given period. For example, if you select a monthly reporting 
period, you’ll have 12 reporting periods a year. Let’s say the first day of 
reporting period 1 is January 1, period 2 is February 1, period 3 is March 1 and 
so on. Your timesheet transactions will then be grouped into 12 periods, with all 
transactions for January falling under reporting period 1, for February under 
period 2, for March under period 3 and so on.

4. Enter the beginning date of the reporting period. The end date is calculated. The 
begin date is based on the reporting period frequency and first date of reporting 
period 1 specified in the Timesheet Setup window of Project Accounting.
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5. Enter or choose a document number. Choose Record Wizard to open the 
Timesheet Wizard window, where you can create a template for your 
timesheets.

In the Timesheet Wizard window, you can choose to load a preexisting 
template, use the template for the previous timesheet or select a template from 
previously created timesheets.

After creating a timesheet template, close the Timesheet Wizard window by 
choosing Process.

When entering a timesheet, you will be asked to copy the existing lines of the 
template into the timesheet if you did not mark Use Timesheet Template in User 
Preferences – Timesheets window, otherwise, the template of the previous 
timesheet will be used.

The document number and period begin date are vital information for locating your 
records. After they have been entered, you can no longer modify them. However, you can 
delete the transaction if it has not been posted, then create a transaction to replace the 
erroneous entry.

6. Enter or select the currency for this timesheet if Multicurrency Management 
features have been activated (optional).

7. Enter a comment for the timesheet (optional).

8. Enter or select a project number. You must enter the project number before you 
can enter a cost category, because the cost category IDs are filtered and only 
those defined for the project you specified are displayed. If you do not enter a 
value in the Project Number field, <NONE>will be displayed to signify that the 
entry is not project-related.

9. Enter or select a cost category. You can enter a cost transaction that doesn’t fall 
under a project. In which case you’ll use a “<NONE>” project. This usually 
happens when a transaction, for example, a timesheet that records the time 
spent for meetings, is not covered by a budget. Employees are still compensated 
for labor hours rendered.

10. Enter or select an employee pay code.

11. Select the billing type. Your options are Standard, No Charge and Non-Billable. 
If your project ID is <NONE>, your billing type must be non-billable.

12. Enter the unit totals. The total amount is calculated. 
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13. Save or submit the entry.

14. Print a copy of the timesheet (optional).

Modifying unposted weekly timesheets

Use the Timesheet Entry window (Weekly) to modify unposted timesheets.

To modify unposted weekly timesheets:
1. Open the Timesheet Entry window.

(Transactions >> Timesheet >> Weekly layout)

2. Select the document number of the transaction you want to modify, then enter a 
new date.

3. Specify additional timesheets in the scrolling window.

4. Modify previous entries.

5. Save or submit the entry.
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Entering standard timesheets

Use the Timesheet Entry window to enter standard timesheets.

To enter standard timesheets:
1. Open the Timesheet Entry window.

(Transactions >> Timesheet >> Date based layout)

2. Select the document type. 

You may need to enter a correction document number to specify the document that is 
being corrected. The Document Type expansion button is inactivated for Standard 
documents.

3. Enter the document date.

4. Enter the number of reporting periods to be included in the timesheet. The 
system displays the reporting period specified in the Timesheet Setup window 
of Project Accounting.

5. Enter the beginning date of the reporting period. The end date will be 
calculated. The begin date is based on the reporting period frequency and first 
date of reporting period 1 specified in the Timesheet Setup window of Project 
Accounting. Reporting periods are useful in tracking the number of hours 
expended on a project within a given period. For example, if you select a 
monthly reporting period, you’ll have 12 reporting periods a year. Let’s say the 
first day of reporting period 1 is January 1, period 2 is February 1, period 3 is 
March 1 and so on. Your timesheet transactions will then be grouped into 12 
periods, with all transactions for January falling under reporting period 1, for 
February under period 2, for March under period 3 and so on.
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6. Enter or choose a document number. Choose Record Wizard to open the 
Timesheet Wizard window where you can create a template for your 
timesheets.

In the Timesheet Wizard window, you load a preexisting template, use the 
template for the previous timesheet or select a template from previously created 
timesheets. After creating a timesheet template, close the Timesheet Wizard 
window by choosing Process.

When entering a timesheet, you will be asked to copy the existing lines of the 
template into the timesheet if you did not mark Use Timesheet Template in User 
Preferences – Timesheets window, otherwise, the template of the previous 
timesheet will be used.

The document number and period begin date are vital for locating records. After they 
are entered, you can no longer modify them. However, you can delete the transaction if 
it has not been posted, then create a transaction to replace the erroneous entry.

7. Enter or select the currency for this timesheet if Multicurrency Management 
features have been activated in Project Accounting (optional).

8. Enter a comment for the timesheet (optional).

9. Enter or select a project number. You must enter the project number before you 
can enter a cost category, because the cost category IDs are filtered and only 
those defined. If you do not enter a value in the Project Number field, <NONE> 
will be displayed to signify that the entry is not project-related.

10. Enter or select a cost category. You can enter a cost transaction that doesn’t fall 
under a project. In which case you’ll use a “<NONE>” project. This usually 
happens when a transaction is not covered by a budget (for example, a 
timesheet that records the time spent for meetings). Employees are still 
compensated for labor hours rendered.

11. Enter or select unit of measure.

12. Enter the quantity that corresponds to the unit of measure. The total amount for 
the transaction will be displayed in the Total Quantity field.

13. Select a billing type. Your options include Standard, No Charge or Non-Billable. 
If your project ID is <NONE>, your billing type must be non-billable.

14. Save or submit the entry.

15. Print a copy of the timesheet (optional).
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Modifying unposted standard timesheets

Use the Timesheet Entry window (Standard) to modify unposted standard 
timesheets.

To modify unposted standard timesheets:
1. Open the Timesheets Entry window.

(Transactions >> Timesheet >> Date based layout)

2. Select the document number of the transaction you want to modify, then enter a 
new date.

3. Specify additional timesheets in the scrolling window.

4. Modify previous entries.

5. Save or submit the entry.

Approving timesheets

Use the Timesheet Approval window to approve submitted timesheets. You can 
examine and approve employee timesheet transactions in the Timesheet Approval 
window. Managers and supervisors can only approve documents submitted by 
their employees. Administrators can process all documents.

If you have Approval and Administrator privileges set up in the User Setup 
window, you can choose to use your administrator privileges. If you choose to use 
your administrator privileges, the Administrator Approvals field will be marked to 
give you a visual indication of the mode you are in. The User Type field will display 
your default user type setting.
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To approve timesheets:
1. Open the Timesheet Approval window.

(Transactions >> Timesheet Approvals)

2. Enter the reporting period.

3. Enter the starting date for the reporting period of the timesheet transaction you 
want to review. The corresponding employee ID assigned to the user that is 
currently logged on will be displayed, if that employee has a timesheet entry for 
the reporting period.

To view another period, adjust the reporting period or enter a period start date. 
If the period start date is not valid, the period will be adjusted to the nearest 
valid period.

The Timesheet Approval window displays timesheet transactions that have a current 
document status of submitted or resubmitted during the current reporting period.

4. Mark Display All if you want to view all submitted documents within the 
reporting period, regardless of their status. If you also want to display missing 
timesheets, mark Display Missing. Mark Process Zero Quantity if you want 
zero transaction line items to carry over to Project Accounting.

5. Choose the Document Number link to open the Timesheet Review and 
Approval window to review the details of the line item. You can either approve 
the displayed items or return it to the employee for modification.

Choose OK to return to the Timesheet Approval window.

6. Choose the Approvals expansion button to open the Approval Status window, 
where the current status of the timesheet is displayed. For processed 
documents, the approval status displayed will be the time the document was 
processed.
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Choose OK to return to the Timesheet Approval window.

7. Choose Approve All to approve all displayed timesheets. Changes in approval 
status are saved. Choose OK to close the window with its current settings. 

An employee can retrieve a submitted or resubmitted document for further viewing at 
any time, regardless of the approval status.

8. Choose Process to process the documents for the reporting period. If the 
approval status is set to Return, then the document will be returned to the 
employee. It is not necessary for both the supervisor and manager to agree to 
return the document before it can be returned. If the document satisfies all of its 
approval requirements, then it will be transferred to the Project Accounting 
system. A timesheet batch is then created in Microsoft Dynamics GP and will 
need to be posted.

If the timesheet transaction has a budget line item with a pending change order, 
the document can’t be processed and transferred to Project Accounting. See the 
Project Accounting documentation for more information about change orders.

If you think a document must have been processed but was not and no message was 
displayed, it is likely that a second approval is required before it can be processed. Verify 
with your system administrator for the approval policies that were set up for the 
employee. Also, the Process button only works for the period being displayed.

9. Print a timesheet edit list (optional).

Entering expense reports

Use the Employee Expense Entry window to enter expenses incurred by an 
employee for a project.

To enter expense reports:
1. Open the Employee Expense Entry window.

(Transactions >> Expense Report)

2. Enter document date.
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3. Enter start and end dates.

4. Enter document number. The document status will be based on the document 
number.

After you have entered the document number, you can no longer modify it. However, 
you can delete the transaction if it has not been posted, then create a transaction to 
replace the erroneous entry.

5. Enter a comment (optional.)

6. Enter the date for the entry.

If the dates entered in the line item entry are outside the start or end date of the 
reporting period, a message will be displayed and you will need to adjust the dates 
entered accordingly.

7. Enter or select a project number. You must enter the project number before you 
can enter a cost category. If you do not enter a value in the Project Number field, 
the field will display <NONE> to signify that e entry is not project-related. 

8. Enter or select a cost category. You can enter a cost transaction that doesn’t fall 
under a project. In which case you’ll use a “<NONE>” project. This usually 
happens when a transaction is not covered by a budget (for example, an 
expense report that records a non-project expense). Employees are still 
compensated for expenses incurred, but not against a project.

9. Enter a description for the item (optional).

10. Select a billing type. Your options are Standard, No Charge, and Non-Billable. If 
your project ID is <NONE>, your billing type must be non-billable. You can 
choose the billing type expansion button to open the Employee Expense Detail 
Entry window. Use the window to include more information for the expense 
report entry. See Entering detailed information for expense reports on page 41 for 
more information.

11. Enter a unit of measure, quantity, and unit cost.

12. Choose More Info to open the Employee Expense Entry – More Info window. 
Use the window to enter employee expense-related information for taxes, 
discounts, payment and shipping. See Entering additional information for expense 
reports on page 41 for more information.

13. Save the entries.
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Entering detailed information for expense reports

Use the Employee Expense Detail Entry window to enter detailed information such 
as expense type, payment method and total cost for each employee expense in the 
transaction for the expense report you’ve selected in Employee Expense Entry 
window.

To enter detailed information for expense reports:
1. Open the Employee Expense Detail Entry window.

(Transactions >> Expense Report >> Bill Type expansion button)

2. Enter the date for the employee expense.

If the dates entered in the line item entry are outside the start or end dates of the 
reporting period, a message will be displayed and you will need to adjust the dates 
entered.

3. Enter or select the project number and cost category. If your project ID is 
<NONE>, your billing type must be non-billable.

4. Enter a description for the employee expense.

5. Enter the quantity and unit cost for the employee expense. The total cost will be 
calculated and will be displayed in the Purchases field.

6. Select the expense type. Your options are Reimbursable and Personal Expense.

7. Select the payment method. You options are Personal Credit Card, Company 
Credit Card and Cash.

8. Enter additional detailed information such as tax options, tax schedule ID and 
calculated taxes, if applicable.

9. Save the entry to return to the Employee Expense Entry window.

Entering additional information for expense reports

Use the Employee Expense Entry - More Info window to enter more detailed 
information for the expense report you have selected in the Employee Expense 
Entry window.
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To enter additional information for expense reports:
1. Open the Employee Expense Entry – More Info window.

(Transactions >> Expense Report >> More Info button)

2. Enter a shipping method for the current document or select from the lookup 
list.

3. Enter a tax schedule for the current document for select from the lookup list.

4. Enter the totals for the following fields: Total Freight, Total Miscellaneous 
Charges, and Terms Discount Taken.

• Total cost is calculated using the following equation: Total Cost = Total 
Purchases + Total Freight + Total Miscellaneous Charges +Total Taxes.

• Reimburse amount is calculated using the following equation: Reimburse 
Amount = On Account - Total Freight - Total Miscellaneous Charges.

5. Choose OK to save the entries.

Entering payments for employee expenses

You can enter payments made to employees in expense transaction records. Open 
the Employee Expense Entry - More Info window by choosing Transactions >> 
Expense Report and choosing the More Info button. You can:

Enter cash payments Choose the Cash expansion button to open the EE Cash 
Entry window and enter the payments.

Enter payments made by check Choose the Check expansion button to open 
the EE Check Entry window and enter the payments.

Enter payments made by credit card Choose the Credit Card expansion 
button to open the EE Credit Card Entry window and enter the payments.

Modifying an unposted employee expense transaction

Use the Employee Expense Entry window to modify an unposted employee 
expense transaction. Employee expenses that are not posted immediately are saved 
in a batch.



P E R S O N A L D A T A K E E P E R 43

C H A P T E R  5    T R A N S A C T I O N S

To modify an unposted employee expense transaction:
1. Open the Employee Expense Entry window.

(Transactions >> Expense Report)

2. Choose the Document Number field; a window will open where you can 
choose to modify the unapproved expense report or create a new expense 
report.

Choose Edit Existing to open the Employee Expenses window.

Select the expense report you want to modify.

3. Modify previous entries.
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4. Choose the Bill Type expansion button in the Employee Expense Entry window 
to open the Employee Expense Detail Entry window. Use the window to specify 
the expense type, payment method and total cost for each employee expense in 
the selected transaction.

5. Choose More Info in the Employee Expense Entry window to open the 
Employee Expense Entry – More Info window. Use the window to enter 
employee expense-related information for taxes, discounts, payment and 
shipping.

6. Submit or save the expense report.
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Approving employee expense transactions

Use the Employee Expense Approval window to approve submitted expense 
reports.

To approve employee expense transactions:
1. Open the Employee Expense Approval window

(Transactions >> Expense Approvals)

2. Select a specific expense report from the scrolling window. In the Approvals 
drop down list, select the approval status for the selected expense report. You 
can also choose Approve All to approve all displayed expense reports.

3. To view the submitted expense report, choose the document number in the 
scrolling window and choose the Document Number link to open the Employee 
Expense Review and Approval window.

Choose OK to return to the Expense Report Approval window.
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4. To view the detailed entry information about the expense report, choose the Bill 
Type expansion button in the Employee Expense Approval window to open the 
Employee Expense Approval Detail window.

Choose Save to return to the Expense Report Approval window.

5. In the Expense Report Approvals window, choose the Approvals expansion 
button to open the Approval Status window. You can use the window to view 
approval status of each user type.

Choose OK to return to the Employee Expense Approval window.

6. In the Expense Report Approvals window, choose Process to process a expense 
report approvals you made in the scrolling window. If the document satisfies all 
of its approval requirements, then it will be transferred to the Project 
Accounting system. A timesheet batch is then created in Microsoft Dynamics 
GP and will need to be posted.

If the expense transaction has a budget line item with a pending change order, the 
document can’t be processed and transferred to Project Accounting. See the Project 
Accounting documentation for more information about change orders.
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Entering transactions offline

You can enter transactions even when you’re not connected to the office network. 
All saved transactions can be uploaded after you get back to the office. See Chapter 
3, “Offline use setup,” for more information.

Offline transactions differ slightly from online transactions. To avoid 
synchronization conflicts, you can’t retrieve previously submitted or resubmitted 
documents in offline mode. This restriction, however, does not apply to documents 
that were generated and submitted offline but that have not been transferred. Other 
changes you will notice offline are:

• The data you can use offline is limited to the data from your last 
synchronization.

• The Project Number lookup contains only the projects specified in the Offline 
Setup window.

• The Timesheet and Expense Report Approvals are not available in offline mode 
even if you have approval permissions.

• The System Setup menu items are inactivated. You must be in connected mode 
to perform System Setup actions.

• The remote menu options Transfer Documents and Synchronize are available in 
the Tools menu.

To enter transactions offline:
1. Start Personal Data Keeper in offline mode.

2. Enter transactions as you would in connected mode.

3. After entering transactions, choose Remote on the Tools menu and choose 
Transfer Document to move your offline documents to the server folders. Only 
remote documents will be transferred.

You can synchronize documents only when you are connected to the office network. You 
must connect either by remote access or being directly connected to the office network.

4. Synchronize data offline by choosing Remote from the Tools menu. Then choose 
Synchronize.

Personal Data Keeper will operate if you have a remote connection and if you 
have started in connected mode, but its performance will be greatly reduced. 
Typically, there is no need to establish connected mode through remote access. 
The only reason to connect remotely is if you need to add projects to your 
offline setup before returning to the office. Quit Personal Data Keeper and 
return to offline mode as soon as the Offline Setup window has synchronized 
your changes.

All transfers and synchronizations are verified before Personal Data Keeper 
updates status or deletes data. If a transfer or synchronization fails, re-establish 
the connection and perform the transfer or synchronization again. The only 
reasons for failure will be a dropped connection or other hardware problems. 
Note that all remote data will be updated upon login in Connected mode.
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Chapter 6: Inquiries
You can view detailed information about employees and transactions. You can view 
detailed information for the employee currently logged into the system. You can 
view employee information in the Employee Inquiry window and timesheets or a 
series of timesheets in the Timesheet Inquiry window. Employee expenses, on the 
other hand, are displayed in the Employee Expense Inquiry window. 

In each inquiry window you can click the Document Number link to open the 
Timesheet Transaction Entry window or Employee Expense Entry window for the 
document.

To print the records that are currently displayed in an inquiry window, choose Print 
from the File menu, from the Report Destination window or using the Print button. 
You can then choose to print to the screen, printer or file.

The following topics are discussed:

• Viewing employee information
• Viewing timesheet information
• Viewing employee expense information

Viewing employee information

Use the Employee Inquiry window to view employee information. You can view 
the current, logged in user‘s detailed information such as the address, employment 
status and local tax code.

To view employee information:
1. Open the Employee Inquiry window.

(Inquiry >> Employee)

2. Choose OK to close the window.
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Viewing timesheet information

Use the Timesheet Inquiry window to view timesheet information. A timesheet is a 
record of the work hours spent by an employee on a project. 

To view timesheet information:
1. Open the Timesheet Inquiry window.

(Inquiry >> Timesheet)

2. Select a document sorting method. You have four ways to view the documents: 
by Project Number, Cost Category ID, Date or Document Number. If you want 
to view a limited number of documents, you can enter a range that will filter all 
records and display only those that you want to see. For instance, if you decide 
to view an unposted timesheet that was created and saved within a period, you 
can view timesheets by date, then identify the documents further by entering 
the beginning date in the From field and ending date in the To field.

3. Choose Redisplay to show item details in the scrolling window.

4. Select a range of project record to display. You can view item details of the 
transactions saved within the range of dates you indicated. For each line item, 
you will see the date, project number, cost category ID, status, quantity, 
document number, employee ID, U of M, billing type and billing description. 
Choose the show and hide button on the scrolling window to see the details or 
just the first line of each record.

If a range is not specified, all documents on file that pass other parameters in the inquiry 
are displayed.



P E R S O N A L D A T A K E E P E R 51

C H A P T E R  6    I N Q U I R I E S

5. To view the original timesheet in the scrolling window, select the Document 
Number field of the line item and choose the Document Number link to open 
the Completed Timesheets window.

6. You can print a copy of the timesheet inquiry by using the Print command in 
the File menu.

Viewing employee expense information

Use the Employee Expense Inquiry window to view employee expense information. 
An employee expense is an allowable cost incurred by an employee while working 
in a project, for example, transportation expenses.

To view employee expense information:
1. Open the Employee Expense Inquiry window.

(Inquiry >> Expense Report)

2. Select the document sorting method. You have four options to view the 
documents: by Project Number, Cost Category ID, Date or Document Number. 

If you want to view a limited number of documents, you can enter a range that 
will filter all records and display only those that you wish to see. For instance, if 
you decide to view unposted expense reports that were created and saved for 
an employee within a period, you can view by date. Then identify the 
documents further by entering the beginning date in the From field and the 
ending date in the To field. 
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Choose Redisplay to show item details in the scrolling window.

3. Select a range of project records to display.

If a range is not specified, all documents on file that pass other parameters in the inquiry 
are displayed.

4. To view the original expense report in the scrolling window, select the 
Document Number field of the line item and choose the Document Number 
link to open the Completed Employee Expense Report window.

5. To view the expense report with more details, choose the Bill Type expansion 
button in the Completed Employee Expense Report window to open the 
Employee Expense Detail Entry window (Inquiry).

Choose OK to close the window.

6. You can print a copy of the expense report using the Print command in the File 
menu.
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Chapter 7: Reports
Reports provide you the option to create hard copies of the transactions you have 
entered and have sent to the accounting system. Unlike the Inquiry feature that 
limits you to four sorting options, the reports feature gives you six sorting options.

Hard copies can also be printed from other windows by choosing Print from the File 
menu. Reports include the User Classes Report, User Security Report, Location 
Translations List, Timesheets Edit List, Employee Expense Edit List, Timesheet 
History List and Employee Expense history.

A typical history report contains all transaction details of timesheets or expense 
records that have been entered in Personal Data Keeper and posted to Microsoft 
Dynamics GP.

The following topics are discussed:

• Printing a history report
• Creating history report options
• Printing a timesheet report
• Printing employee expense reports
• Printing missing timesheets
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Printing a history report

Use the Project Series History Reports window to print reports containing entries 
such as submitted or missing timesheets and expense reports.

To print a history report:
1. Open the Project Series History Reports window.

(Reports >> History)

2. Select the report you want to print. From the Reports list, select the report. Your 
options are Timesheets and Employee Expense.

3. Add or modify option items. The Project History Report Options window will 
be displayed when you create a new option or modify an existing option. See 
Creating history report options on page 55 for more information.

4. After you have selected or created a report option, choose Print to open the 
Report Destination window.

If you have previously chosen a report destination and did not mark the Ask Each Time 
option, your report will be printed based on your previous report destination.

Reports can be saved in the following formats:

After selecting a file format, name the file. If you have entered an existing file 
name, choose whether to add the report to the bottom of the existing file or 
replace the information in the existing file.

Choose OK to return to the Project Series History Reports window.

5. Choose Print to print the report.

File type Description

HTML Hypertext Markup Language or HTML marks or tags a 
document so it can be published in the World Wide Web.

Tab-delimited Fields A tab-separated ASCII character format used by Microsoft 
worksheet programs, such as Microsoft Excel®.

Comma-delimited Fields A standard comma-separated ASCII character format used by 
database programs.

Text file Reports will be saved as text without formatting
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Creating history report options

Use the Project History Report Options window to specify a range of information to 
include on the report. If you specify range restrictions for a report, you must insert 
the range in the Restrictions box. If you don’t, the report will be printed without 
restrictions.You can print reports for more than one restriction of the same type by 
entering only one restriction for each restriction type. For example, if you want to 
restrict a report for customer IDs A to F and M to S, you can create two report 
options for the selected report. Enter the first restriction (customer IDs A to F) for 
the first report option, and enter the second restriction (customer IDs M to S) for the 
second report option.

To create history report options:
1. Open the Project History Report Options window.

(Reports >> History >> New button)

2. Select or enter an option.

3. Specify a sorting method and items to include. Enter range restrictions. There 
are six options on the range list: Employee ID, Cost Category ID, Date Incurred, 
Document Date, Document Number and Project Number. The Employee ID 
Range is set for the current logged-in user only and can’t be modified. The From 
and To fields and lookup lists will vary depending on the specified range.

If you have not chosen a report destination, choose Destination to open the Report 
Destination window. After specifying the report destination, choose OK to return to the 
Project History Report Options window.

4. Choose Print to print the report option.
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Printing a timesheet report

Use the Project History Reports window to print timesheet reports. The timesheets 
report provides a complete list of posted timesheet transactions. The timesheet 
transaction details include the employee ID, date, document number, project 
number, cost category ID, status, billing type, U of M, and quantity. Report totals are 
also provided at the bottom of the report.

To print a timesheet report:
1. Open the Personal Data Keeper History Reports window.

(Reports >> History)

2. Select Timesheet from the Reports drop-down list. 

3. Add or modify option items. The Project History Report Options window will 
open when you create a new option or modify an existing option.

4. Enter range restrictions. There are six options on the range list: Employee ID, 
Cost Category ID, Date Incurred, Document Date, Document Number and 
Project Number. The Employee ID Range is set for the current logged-in user 
only and can’t be modified. The From and To fields and lookup lists will vary 
depending on the specified range.

5. Insert the selected option items to the print list or delete an item from the print 
list.

6. Choose Destination to display the Report Destination window. You have the 
option of printing the report to the screen or sending it to a file or printer. If you 
choose Ask Each Time, you will be able to choose printing options each time 
you print the report. Otherwise, leave Ask Each Time unmarked and the report 
will be sent to the previously marked destination.

Reports can be saved in the following formats:

After selecting a file format, name the file. If you have entered an existing file 
name, choose whether to add the report to the bottom of the existing file or 
replace the information in the existing file.

Choose OK to return to the Project History Report Options window.

7. Choose Print to print the report.

The timesheets report can be printed from either the Project Series History Reports 
window or the Project History Report Options window. See Printing a history report on 
page 54 for more information.

File type Description

HTML Hypertext Markup Language or HTML marks or tags a 
document so it can be published in the World Wide Web.

Tab-delimited Fields A tab-separated ASCII character format used by Microsoft 
worksheet programs, such as Microsoft Excel.

Comma-delimited Fields A standard comma-separated ASCII character format used by 
database programs.

Text file Reports will be saved as text without formatting.
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Printing employee expense reports

Use the Project History Reports window to print employee expense reports. The 
employee expenses report provides a list of all posted employee expense 
transactions. It shows transaction details, including the employee ID, date, 
document number, project number, cost category ID, status, billing type and 
quantity. Report totals are also displayed at the end of the document.

To print an employee expense report:
1. Open the Project Accounting History Reports window.

(Reports >> History)

2. Select Employee Expense from the Reports drop-down list. 

3. Add or modify option items. The Project History Report Options window will 
open when you create a new option or modify an existing option.

4. Enter range restrictions. There are six options on the range list: Employee ID, 
Cost Category ID, Date Incurred, Document Date, Document Number and 
Project Number. The Employee ID Range is set for the current logged-in user 
only and can’t be modified. The From and To fields and lookup lists will vary 
depending on the specified range.

5. Insert the selected option items to the print list or delete an item from the print 
list.

6. Choose Destination to display the Report Destination window. You have the 
option of printing the report to the screen or sending it to a file or printer. If you 
choose Ask Each Time, you will be able to choose printing options each time 
you print the report. Otherwise, leave the Ask Each Time option unmarked and 
the report will be sent to the previously marked destination.

Reports can be saved in the following formats:

After selecting a file format, name the file. If you have entered an existing file 
name, choose whether to add the report to the bottom of the existing file or 
replace the information in the existing file.

Choose OK to return to the Project History Report Options window.

7. Choose Print to print the report.

The employee expense report can be printed from either the Project Accounting History 
Reports window or the Project History Report Options window. See Printing a history 
report on page 54 for more information.

File type Description

HTML Hypertext Markup Language or HTML marks or tags a document 
so it can be published in the World Wide Web.

Tab-delimited Fields A tab-separated ASCII character format used by Microsoft 
worksheet programs, such as Microsoft Excel.

Comma-delimited 
Fields

A standard comma-separated ASCII character format used by 
database programs.

Text file Reports will be saved as text without formatting.
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Printing missing timesheets

Use the Missing Timesheets window to print a list of missing timesheets.

To print missing timesheets:
1. Open the Missing Timesheets window.

(Reports >> Missing Timesheets)

2. Enter a reporting period you want to view.

3. Enter or select a starting period date. The end date is calculated.

The Print by Emp. Manager/Supervisor option is active if the user has administrator 
approvals on timesheets. When this option is active, a missing timesheet report that is 
grouped by the manager or supervisor is displayed.

4. Choose Print to print the list of missing timesheets.
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Glossary
Account

The type of record—asset, liability, revenue, 
expense or owner’s equity—traditionally 
used for recording individual transactions in 
an accounting system. Also, the identifying 
alphanumeric characters that have been 
assigned to the record. 

Actual cost
The cost of an item as recorded on the 
purchase receipt. For example, if you 
received 3 boxes and they cost $15 each, the 
actual cost would be $45. 

Adjustment
Increase or decrease in quantity or cost.

Bank card
A type of credit card. Bank cards include 
ATM cards, that when used by a customer, 
enables funds to be transferred directly into 
your bank account. Bank cards also include 
cards issued by a bank based on a credit 
rating and typically do not carry a credit 
limit. The bank that issued the card will see 
to it that the seller receives payment. 
Payments received from the cards are treated 
as check or cash payments.

Billing note
A short description, message or instruction 
about billing for a cost category, transaction, 
fee, project, contract or some other item in a 
project.

Billing rate
A profit type that uses a fixed rate. The rate 
includes costs and profit.

Billing type
A setting that indicates whether an item is to 
be billed, not to be billed or offered free of 
charge.

Cash
Ready money or its equivalent that a bank 
will accept at face value. Cash includes coins; 
paper money; certain deposited negotiable 
instruments such as checks, bank drafts and 
money orders; amounts in checking and 
savings accounts; and demand certificates of 
deposit.

Checkbook
An account used to maintain a currency 
balance and track the receiving and 
disbursing of cash. 

Class 
A group of users, contracts, projects, cost 
categories, equipment or other items that are 
combined based on common characteristics. 
For example, a project class can be created to 
group projects according to budget or 
location.

Contract
A group of projects that a contractor 
performs for a customer, and for which the 
contractor charges the customer for various 
costs. For example, the contract Marketing 
Services may be made up of the projects 
Printing Brochures and Log Design.

Cost category
A name assigned to a project expense. For 
example, labor, building rental, or purchase 
of computers. When a cost category is used 
in a project, it is called a “budget item.” Each 
cost category has its own budget.

Credit card
Cards used to pay for items instead of a 
check, cash or other method. The amount 
due is then billed by the credit card 
company. Using the Credit Card Setup 
window, cards used to make payments can 
be classified as credit cards or check cards. 
Cards accepted as payment by a company 
can be classified as bank cards or charge 
cards.

Currency 
A form of money, including bills and coins, 
used as a medium of exchange.

Cutoff date
A specific number of days set before the 
billing date. Transactions or line items with 
dates beyond the cutoff date will not be 
included in the billing.

Default
A value that is automatically displayed in a 
window. The default will be used unless 
another value is entered. 

Department
A business division or unit that incurs costs 
and/or generates revenue. 

Department code
A unique set of characters used to identify a 
department.

Discount available
A reduction in the amount payable, typically 
offered if the payment is made by a certain 
date.

Discount date
The date an invoice must be paid for a 
discount to be valid.

Document number
A number that identifies a group of entries 
that have been posted as a single, complete 
transaction.

Employee expense
An allowable cost incurred by an employee 
while working in a project such as 
transportation expenses.

Freight
The cost of transporting goods.

Functional currency
The primary currency in which a company 
maintains its financial records. Typically, the 
functional currency is the currency for the 
country/region where the company is 
located.

History 
A record of checks and transactions for 
previous and current years.

Hourly pay
A pay code used to pay employees an 
amount per hour worked.

Item number
A number that identifies one type of 
inventory item. Inventory items can be used 
in transaction entry only if item numbers 
have been assigned.

Line item
An entry that is displayed in a row of a 
scrolling window.

Markup percentage
A profit type that calculates profit as a 
percentage of unit cost.

<NONE>
An entry indicating that an item or expense 
is not covered by a budget or is not part of a 
project.

Originating currency
The foreign currency that a multicurrency 
transaction was conducted in.

Pathname
A location in a computer’s hard disk or in a 
network where files are created and stored. 

Pay code 
A code used to identify a specific type and 
rate of pay. For example, employees who are 
paid a salary rate may have the pay code 
SAL assigned to them.

Pay rate 
The amount an employee is paid for work 
rendered over a specific period or for a 
specific amount of work.

Payment terms
Conditions for payment that are extended to 
customers and that vendors may extend to a 
company. For example, the payment term 
2%-10/Net 30 offers a 2% discount for 
customers who pay within 10 days after the 
date of purchase; otherwise the bill must be 
paid in full within 30 days.

Position
Name assigned to a job, position or 
designation.

Position code
A unique alphanumeric name used to 
identify a job or position.
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Posting
A procedure to make temporary transactions 
a part of a business’s permanent records; to 
update accounts by transaction amounts. In 
manual accounting, posting transfers journal 
entries to the proper accounts in a general 
ledger.

Posting account
A financial account that tracks assets, 
liabilities, revenue or expenses. 

Project Accounting
A project management module used for 
budgeting resources, managing purchases, 
scheduling tasks, monitoring costs, billing 
customers and recognizing revenues.

Project types
A project classification used to determine 
how a contractor is to calculate project costs 
and charge customers for such costs. It is also 
a way to determine how much revenues can 
be generated in a project. There are three 
project types in Project Accounting: cost 
plus, fixed price and time and materials.

Record
A collection of related fields within a table. 
Records typically comprise most or all of the 
data entered in the fields in a given window. 
For instance, all the information entered 
about a specific account in the Account 
Maintenance window makes up a single 
record. A single transaction entered in the 
Transaction Entry window also constitutes a 
record.

Referenced 
A type of transaction that is used to correct 
another posted transaction by increasing or 
decreasing the quantity of the previous 
transaction.

Roll down
The process of applying changes you’ve 
made in one record to all other records 
within a class, or to all records using the ID 
of the record you changed.

Shipping method
A method of transporting goods or services, 
such as parcel post.

Standard 
A regular transaction or a corrected 
unposted transaction.

Status
Indicates the progress of a project, contract 
or cost category: estimate, open, on hold, 
completed, and closed. Actions such as 
transaction entry, posting, billing, and 
revenue recognition depend on the status.

Tax detail
A definition of a tax that may apply to sales 
or purchases. Tax details are grouped into 
schedules. 

Tax schedule 
Groups of tax details that define each tax that 
may apply to sales or purchases. When tax 
schedules are assigned to vendors, the 
applicable taxes will be calculated during 
transaction entry.

Timesheet
A record of the labor cost and time expended 
on a project.

Timesheet Template
A template used to simplify timesheet entry.

Trade discount
A discount given by a vendor or received by 
a customer. The rate is calculated at the time 
of a purchase or sale and is added to 
payment term discounts that may also be 
available.

Transaction
An event or condition that is recorded in 
asset, liability, expense, revenue, and/or 
equity accounts. Sales to customers or 
purchases from vendors are examples of 
transactions.

Unit cost 
The amount per unit that you pay for an item 
you’re planning to sell or consume.

Unit of measure 
The quantities in which your business buys 
or sells an item. For example, your business 
might sell soda in three units of measure: 
cans, six-packs, and cases. One can of soda 
would equal the unit of measure “Each” or 
“Can.” Six cans would equal “Pack,” and 24 
cans would equal “Case.” 

Unit of measure schedule 
A group of related units of measure. For 
example, your business might sell soda in 
three units of measure: cans, six-packs, and 
cases. One can of soda would equal the unit 
of measure “Each” or “Can.” Six cans would 
equal “Pack,” and 24 cans would equal 
“Case.” The unit of measure schedule for 
soda would define each of the U of Ms based 
upon Can, the equivalent common to all U of 
Ms.

User 
A person working with software on a 
computer; a computer operator.

User class 
A classification feature in which users are 
grouped and levels of access are assigned to 
information in the accounting system.
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49
Employee Expense Inquiry window

displaying 49
viewing employee expense 

information 49
employee expense reports, printing 55

Employee Expense Review and Approval 
window

approving employee expense 
transactions 43

displaying 43
employee expenses, reports 55
employee information, viewing 47
Employee Inquiry window

displaying 47
viewing employee information 47

expense preferences, setting up 26
Expense Report Approvals window

approving employee expense 
transactions 43

displaying 43
expense report options, setting up 13
expense reports

additional information 39
approving 43
detailed information 39
entering 37
modifying 40
offline 45

Expenses window
displaying 16
setting up user class expense options 

16

H
help, displaying 3
Help menu, described 3
history report options, creating 53
history reports, printing 52

I
icons, used in manual 3
inquiries

viewing employee expense 
information 49

viewing employee information 47
viewing timesheet information 48

installation
before you begin 7
new installations 7
upgrades 8

L
Login window

displaying 10
selecting a company 10

lookup window, displaying 4

M
Missing Timesheets window

displaying 56
printing missing timesheets 56

N
navigation, symbols used for 3

O
offline setup, about offline use 21

Offline Setup window
displaying 22
setting up for online use 22

offline transactions, entering 45

P
Project History Report Options window

creating history report options 53
displaying 53

Project Series History Reports window
displaying 52
printing history reports 52

R
registration keys, entering 18
Registration window

displaying 18
entering registration keys 18

reports
creating history report options 53
missing timesheets 56
printing employee expenses 55
printing history reports 52
printing timesheet reports 54

required fields, described 4
resources, documentation 3

S
security options, setting up 17
Security Setup window

displaying 17
setting up security options 17

setup
expense preferences 26
expense report options 13
registration keys 18
security options 17
system password 18
timesheet preferences 24
user class 14
user class expense report options 16
user class options 15
user class timesheet options 15
user display preferences 24
user ID 10
user password 26
user preferences 23
user timesheet options 11

standard timesheets
entering 33
modifying 35

symbols, used in manual 3
system password, setting up 18
System Password Setup window

displaying 18
setting up the system password 18

T
Timesheet Approval window

approving timesheets 36
displaying 36
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Timesheet Entry window
displaying 30
entering standard timesheets 33
entering weekly timesheets 30
modifying unposted standard 

timesheets 35
modifying unposted weekly 

timesheets 32
timesheet information, viewing 48
Timesheet Inquiry window

displaying 48
viewing timesheet information 48

timesheet options, setting up 11
timesheet preferences, setting up 24
timesheet reports, printing 54
Timesheet Settings window

displaying 12
setting up timesheets 12

timesheets
approving 35
offline 45
reports 54
standard 33
weekly 30

Timesheets window
displaying 16
setting up user class timesheet 

options 16
transactions

approving expense reports 43
entering additional information for 

expense reports 39
entering detailed information for 

expense reports 39
entering expense reports 37
entering standard timesheets 33
entering weekly timesheets 30
modifying standard timesheets 35
modifying unposted expense reports 

40
modifying weekly timesheets 32
offline entry 45
timesheet approvals 35

U
user class expense report options, setting 

up 16
user class options, setting up 15
User Class Options window

displaying 15
setting up user class options 15

User Class Setup window
displaying 14
setting up user classes 14

user class timesheet options, setting up 15
user classes, setting up 14
user display preferences, setting up 24
User Display Preferences window

displaying 24
setting up user display preferences 24

user ID, setting up 10

user password, setting up 26
User Password Setup window

displaying 26
setting up user passwords 26

user preferences
overview 23
setting up 23

User Preferences - Expenses window
displaying 26
setting up expense preferences 26

User Preferences - Timesheets window
displaying 25
setting up timesheet preferences 25

User Preferences window
displaying 23
setting up user preferences 23

User Setup window
displaying 10
setting up user IDs 10

W
weekly timesheets

entering 30
modifying 32


	Copyright
	Contents
	Introduction
	What’s in this manual
	Symbols and conventions
	Resources available from the Help menu
	Send us your documentation comments

	Part 1: Installation and setup
	Chapter 1: Installation
	Before you begin
	Completing a new installation
	Upgrading from Release 8.0 or 9.0

	Chapter 2: System setup
	Logging in to Personal Data Keeper
	Selecting a company
	Setting up a user ID
	Setting up timesheet options for a user
	Setting up expense report options for a user
	Setting up a user class
	Setting up user class options
	Setting up user class timesheet options
	Setting up user class expense report options
	Setting up security options
	Setting up the system password
	Entering registration keys

	Chapter 3: Offline use setup
	About offline use
	Setting up for offline use

	Chapter 4: User preferences
	Setting up user preferences
	Setting up user display preferences
	Setting up timesheet preferences
	Setting up expense report preferences
	Setting up your user passwords


	Part 2: Procedures
	Chapter 5: Transactions
	Default pay codes
	Entering weekly timesheets
	Modifying unposted weekly timesheets
	Entering standard timesheets
	Modifying unposted standard timesheets
	Approving timesheets
	Entering expense reports
	Entering detailed information for expense reports
	Entering additional information for expense reports
	Entering payments for employee expenses
	Modifying an unposted employee expense transaction
	Approving employee expense transactions
	Entering transactions offline

	Chapter 6: Inquiries
	Viewing employee information
	Viewing timesheet information
	Viewing employee expense information

	Chapter 7: Reports
	Printing a history report
	Creating history report options
	Printing a timesheet report
	Printing employee expense reports
	Printing missing timesheets


	Glossary
	Index
	A
	C
	D
	E
	H
	I
	L
	M
	N
	O
	P
	R
	S
	T
	U
	W


